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Assign to an Advisor

L2: Assign to Advisor

*Assign To:

Enter First or Last Name

Comments:

File = Edit~ Insert « View = Format « Table »

& @ |Fomasy | B [

A ~ [A v~ © @ FontFamily ~  FontSizes

Insert Image

4. Upload File:

Choose Files | No file chosen



Escalation

Escalate to Level 2

Comments:

File » Edit ~ Insert = View v Format ~ Table »

N » Formats « B 7 =

Tools »

& M
= @& [pBF A - [A v © | FontFamily -

Font Sizes

Insert Image

4. Upload File:

Choose Files | No file chosen

(Max 10 files or 20MB)




Setup

Blackboard SmartView™  Department (Demo)Monument2  Institution: Monument2

L Setup v Search '« Actions:
A~ Setup 4 Add/Edit Advisor
Components Advisor v *Display Name:
First Name:
Last Name:

4 Advisor Setup (26)

['_;'_:" J . Advisor ID:

() Display Name Active Delete *Email:

(] Amanda York false x

o BbSS - Bonnie Watts true x *Work Phone:

0 Christopher Diaz true x

@ Cory White true x Home Phone:

()] Demo true x

O Demo User true ® Aciive; O
| DemoKBManager true x Advisor Roles:

] DemolL1User true ® *Role Group: T v
O DemoL2User true ®




Workflow Management Cases

Blackboard SmartView™  Department (Demo)Monument2  Institution: Monument2

2 Case v 1582 - Qv Actions: More Actions ~ J
e s Edit
. ase summa
Views All - Unresolved (41) v b Escalate to Level 2 -
Ticket#: 1582-167 Status: Work In Progress it
: Need More Info =
Date Created: 2015-12-08 09:18:40 AM Date Modified: 2015-12-09 06:55:30 PM
Queues --Please Select-- hd : Post External Comment -
Assigned To: Demo User Entered By:
Post Internal Comment r
4 All - Unresolved (4 7 ; Suggest Solution
All - Unresolved (41) ad 4 Case Details 9
S " To Trash [
Case # Created Date Status Original Email-To:
1582-167 2015-12-08 09:18:40 AM Work In Progress Case Origin: BbSS - Web Ticket
1582-165 2015-11-30 01:47:45 PM Queue Assigned Role: Student
1582-163 2015-11-30 01:08:01 PM Queue Assigned Request: Student Accounts
1582-157 2015-11-05 05:53:21 AM Queue Assigned Request Type: Holds or Service Indicators
1582-148 2015-10-09 12:33:22 AM L2: Work In Progress Summary: registration
1582-140 2015-09-16 10:59:31 PM Queue Assigned Description: when can | registration
1582-123 2015-09-03 10:10:32 AM Queue Assigned -
Internal Notes:
1582-122 2015-08-18 09:19:27 AM L2: Work In Progress 2
Attachments:
1582-121 2015-08-18 08:12:55 AM L2: Queue Assigned
1582-120 2015-08-18 12:12:18 AM Queue Assigned )
4. Case History
Performed By Action Action Date
‘ - sl | ot | bl | B Demo User Grab 2015-12-09 06:55:30 PM
Advisor: Demo
Notifications:




Ticketing — Create a Case

Blackboard SmartView™

Departiment: (Demo)Monument2

Institution: Monument2

2 Case v 1582 -

Views All - Unresolved (41)

Queues --Please Select--

Actions:

4. Case Info

*Contact: None - Select Contact

4. Case Details:

*Case Origin: Monument - Walk Up v
4. All - Unresolved (41) e
Case # Created Date Status *Role: - Please Select — v
1582-167 2015-12-08 09:18:40 AM Work In Progress
1582-165 2015-11-3001:47:45 PM Queue Assigned *Summary:
1582-163 2015-11-30 01:08:01 PM Queue Assigned
1582-157 2015-11-05 05:53:21 AM Queue Assigned *Description:
1582-148 2015-10-09 12:33:22 AM L2: Work In Progress
= File » Edit~ Insert » View = Format v Table = Tools »

1582-140 2015-09-16 10:59:31 PM Queue Assigned
1582-123 2015-09-03 10:10:32 AM Queue Assigned “ Formats « B I =E =E E=E = EE - 55 > = = oo ™
1582-122 2015-08-18 09:19:27 AM L2: Work In Progress — —— = — — ———————— —
1582-121 2015-08-18 08:12:55 AM L2: Queue Assigned o bl A = O, [l Footbamiy = | Fontsizes > || lnsortimage
1582-120 2015-08-18 12:12:18 AM Queue Assigned




Mobile

00000 ATRT = 12:59 PM 40 3} 50%0C 00000 ATRT & 1:00 PM 40 % 50%C
8 servicedesk.edusupportcenter.com

& servicedesk.edusupportcenter.com C

Actions:
Blackboard SmartView™
"‘ Ci 1708 - Q M Title: Update Schedules - Blackboard
Last 2016-03-16 03:00:50 PM
Views All - Unresolved (68) Updated:
Content: S INTERNAL USE ONLY --emcnemnaan

->

Queues --Please Select--

Account information is handled manually by
the administrators, once accounts are created,

4 All - Unresolved (68) e users are notified via email.

Course information data feeds occur one

Case # Created Date Status . .

week prior to the start of class, then on a daily
1708-9358 2016-04-15 10:51:07 AM L3: Queue Assigned basis for three (3) weeks after the start of
1708-9357 2016-04-15 10:50:26 AM L3: Queue Assigned class.
1708-9355 2016-04-1509:51:16 AM L3: Queue Assigned PR INTERNAL USE ONLY --ooommmeee
1708-9353 2016-04-15 09:36:16 AM L3: Queue Assigned >
1708-9334 2016-04-14 12:59:13 PM L3: Queue Assigned
1708-9331 2016-04-14 11:19:49 AM L3: Queue Assigned
1708-9330 2016-04-14 10:55:58 AM L3: Queue Assigned Article Update, Schedule, creation, account,
1708-9324 2016-04-13 08:57:59 PM L3: Queue Assigned Keywords:

Internal: 4

< I__T—I m @ | Published: «




SmartView
Self Help Support Services Portal
For Students



Self-Services Portal — Responsive Design

MONUMENT

My Help Center  Create Case  Sign Out  Modify Password

@ MONUMENT My Help Center  Create Case  Sign Out  Modify Password

SUBMIT

Home / My Progress

Contact Us

@ MONUMENT

1 855 815-8408

Help Cases ISR  Create Case

Chat
2477 Support

== Financial Aid Tracker 20152016
Help Articles Track My Progress Password Reset
Browse self-help articles  View the status of your Reset your Password
on admissions, financial  admission, registration,
aid, academics and other  financial aid or student
needs account

Top Help Topics

2014-2015: Current Aid Year

—

SUBMIT YOUR FAFSA SATISFY YOUR ELIGIBILITY REVIEW ACT ON YOUR LOANS AID POSTING
REQUIREMENTS AND AWARD NOTICE

Do | have to take the SAT/ACT

Help Arti
e vy elpprices

When are the 1098-T Tuition
Statements mailed?
i 1 had my test scores sent to
Get Support By Topic the colege wtycont.

As an international admissions DETAILS

-
ML Admissions applicant, can | email.

 Rec Why didn't | get the amount
Student fecords that FAFSA said | was

Track My Progress
iew e sats o your adssln, regisccon, nancilaid o st acouns Our records indicate that you have outstanding documents that need to be submitted to our office so we can process your aid application. Please visit

www,mu.edulfastatus to view these documents. You can submit these documents by creating a ticket at www.help.mymu.edu.

Once we have received all of your documents, we can continue to process your aid applcation. Please allow up to three (3) business days for us to review your

(] P Why did | get a revised award
i Academics/Advising documents and update your financial aid status.

notification?

& Student Accounts Logging In To Learn - Instructor
- Blackboard Learn.

Password Reset
& Financial Aid Course Avalabilty - Blackboard

9.15P14
0 uws

Technical Support

Login to MyMU Get Support By Topic
Wireless Quick Start Guide:
Internet Connection for...

Browse All Articles by Topic > -

Self-Help Portal Status Trackers

11



Self-Service

@ MONUMENT

How can we help?

My Help Center

Create Case

Sign Out  Modify Password

Q Search by phrase or keyword SUBMIT ‘

LIVE CHAT

Help Articles

Browse self-help articles on
admissions, financial aid,

Track My Progress

View the status of your
admission, registration,

Password Reset
Reset your Password

academics and other needs financial aid or student account

Get Support By Topic

Admissions

Academics/Advising

@ e B

Financial Aid

Technical Support

Browse All Articles by Topic >

Student Records

x Student Accounts

O s

Contact Us

1855 815-8408
" Chat

24/7 Support

Top Help Topics

Do | have to take the SAT/ACT in order to
apply for...

When are the 1098-T Tuition Statements
mailed?

| had my test scores sent to the college;
why don't...

As an international admissions applicant,
can | email...

Why didn't | get the amount that FAFSA
said | was...

Why did | get a revised award
notification?

Logging In To Learn - Instructor -
Blackboard Learn...

Course Availability - Blackboard 9.1 SP14
Login to MyMU

12



Mobile Ready

13

®eee0 \erizon LTE 1:21 PM @ 7 % 88% )

& monument2.edusupportcenter.com

Q MY HELP CENTER CREATE CASE SIGN OUT

Home / My Progress

CE—

Help Cases Create Case

Financial Aid Tracker

2014-2015 2015-2016

2014-2015: Current Aid Year

SUBMIT YOUR FAFSA

13



Support Ticket Summary

@ MONUMENT

Help Center Cases

Help Cases Trackers ~ Create Case

Cases listed below are from the last 120 days.

Case Number
1582-57
1582-56
1582-55 [v]
1582-54
158249 [¢]

1582-46

Title

when will | receive my financial aid letter in the mail

when will | receive financial aid letter

Financial aid

Test

Financial Aid

Financial Aid Question

My Help Center  Create Case

Sign Out

Modify Password

Q search by phrase or keyword

Last Updated

2015-05-20 10:24:45

2015-05-19 20:34:58

2015-05-1510:28:22

2015-05-15 10:20:59

2015-05-06 14:17:07

2015-04-09 18:37:29

Status

Queue Assigned

Queue Assigned

Closed

Queue Assigned

Closed

Queue Assigned

14



Automated Password Reset

@ MONUMENT My Help Center  Create Case  Sign Out  Modify Password

Q Search by phrase or keyword

Reset Password

Reset Password

Please complete all fields in order to reset your Monument2 password.

First Name:|:|

Last Name:|:|

Employee ID or Student ID:|:|
4 Digit BirthYear:|:|

New Password:|:|

Confirm New Password:|:|

swKCcGlol
Type the Code Shown::

Type in all characters as they appear in the box.
For alternate words press the refresh button on the upper right.

15



SmartView

Admission, Financial Aid & Student
Account Trackers

For Students & Staft



Admissions Tracker

@ MONUMENT My Help Center  Create Case  Sign Out  Modify Password

Q Search by phrase or keyword

Help Cases Create Case

Admissions Tracker

z :

APPLICATION ACCEPTED REGISTER
ORIENTATION ASSESSMENT ADVISOR

DETAILS

We show that you have not yet finished your admission application and submitted it for consideration. Be sure to complete all required elements and submit the application via
MU.edu/applynow.

17



Financial Aid Tracker

@ MONUMENT My Help Center  Create Case  Sign Out  Modify Password

Q Search by phrase or keyword

Help Cases Create Case
Financial Aid Tracker 20152016

2014-2015: Current Aid Year

SUBMIT YOUR FAFSA SATISFY YOUR ELIGIBILITY REVIEW AND ACT ON YOUR LOANS AID POSTING
REQUIREMENTS AWARD NOTICE

DETAILS

Our records indicate that you have outstanding documents that need to be submitted to our office so we can process your aid application. Please visit www.mu.edu/fastatus to view these
documents. You can submit these documents by creating a ticket at www.help.mymu.edu.

Once we have received all of your documents, we can continue to process your aid application. Please allow up to three (3) business days for us to review your documents and update your
financial aid status.

18



Student Accounts Tracker

@ MONUMENT My Help Center  Create Case Sign Out  Modify Password

Q Search by phrase or keyword

Help Cases Create Case

Student Accounts Tracker

SERVICE HOLDS BALANCE DUE PAYMENT STATUS REFUNDS 1098-T TAX FORM

DETAILS

Our records indicate that you have a balance due on your account. You arrange a payment through your online account on www.mymu.edu or by visiting our student affairs office.

19



SmartView
Integrated Advisor Desktop
For Staff



Integrated Advisor Desktop — ISIR Info

Blackboard SmartView™ Institution: Monument2 Advisor: Demo User(10051005)

Greeting Case LMS Password Reset

E Demographic Tracker Service Indicators Financial Aid Information Financial Aid Communication Student Accounts
Display Name: Academic Records and Registration
First Name: Andrew
Middle Name: X Select Financial Year:
Last Name: Jackson AID YEAR: 2015
Student ID: 1
Date of Birth: 1967-03-15 AID YEAR: 2014
Email: andrew.jackson@mo
nument.edu [=] AID YEAR: 2013
Personal Email:
Marital Status: MARRIED [=] ISIR Activity
Gender: MALE
National ID: 1111 CPS Institution
Selected Selected Global's ISIR CPS
Preferred Phone: 5714641111 Load Transaction ISIR Dependency for for Verification File Correction Processed Primary Transaction
FERPA Indicator: No Release Status Number Status  Status Verification Verification Result Status Status Date EFC Date
Approved
FERPA Access: loaded 5 Current Dependent SELECTED  Confirm N 2012-02- 2300.00 2012-03-10
documents 15
k Preferred Mailing Address:MA in the
Checklist
Address 1: 123
Address 2: STREET
Address 3: Need Summary
City: YOURTOWN
State: VA [=] Award Activity
Postal: 12345 Award Name: Pell
Country: USA
R Offered Accepted Net Aid Disbursed Actual Term
k Parent Action Action Anticipated Term Award Award to Student  Disbursement
Term Date Status Disbursement Date Amount Amount Memoed Authorized Account Date
Display Name:
First Name: Fall Disbursed @ 2750.00 0.00 0.00 2750.00 0.00 2012-08-25
2013
Middle Name:
Last Name: Spring Disbursed @ 2750.00 0.00 0.00 2750.00 0.00 2013-01-10
2013
Person ID:
Date of Birth: Total 5500.00 0.00 0.00 5500.00 0.00




Integrated Advisor Desktop — FA Awards

Blackboard SmartView™ Institution: Monument2  Advisor: Demo User(10051005)

Case

Greeting

Integration

k Demographlc Tracker Service Indicators Financial Aid Information Financial Aid Communication Student Accounts Academic Records and Registration
Display Name: Select Financial Year: = please select B
First Name: Andrew AID Y . 2015
Middle Name: X
Last Name: Jackson [=] AID YEAR: 2014
Student ID: 1
Date of Birth: 1967-03-15 ISIR Activity
Email: andrew.jackson@monu
ment.edu Need Summary
Personal Email:
Marital Status: MARRIED [E] Award Activity
Gender: MALE Award Name: Pell
National ID: 111
Offered Actual Term
Preferred Phone: 5714841111 Action  Action Anticipated Term A d Net Aid D sed Disb
FERPA Indicator: No Release Approved Term Date Status Disbursement Date Amount Award Amount Memoed Authorized to Student Account Date
FERPA Access: Fall Disbursed @ 2750.00 0.00 0.00 2750.00 0.00 2012-08-25
k Preferred Mailing Address:MA 2014
Spring Disbursed @ 2750.00 0.00 0.00 2750.00 0.00 2013-01-10
Address 1: 123 2014
Address 2: STREET
Address 3: Total 5500.00 0.00 0.00 5500.00 0.00
City: YOURTOWN
Award Name: SEOG
State: VA
Postal: 12345 Offered Actual Term
Country: USA Action  Action Anticipated Term ard Accepted Net Aid Disbursed Disbursement
’ Term Date Status Disbursement Date A A M d Authorized to Student Account Date
k Parent
Fall Disbursed @ 1250.00 0.00 0.00 1250.00 0.00 2012-08-25
Display Name: 201
First Name: Spring Disbursed @ 1250.00 0.00 0.00 1250.00 0.00 2013-01-10
Middle Name: 2014
Last Name: Total 2500.00 0.00 0.00 2500.00 0.00
Person ID:
Date of Birth: Award Name: Instutional Grant
EMAIL:
Offered Actual Term
Gender: Action  Action Anticipated Term Award Accepted Net Aid Disbursed Disbursement




Integrated Advisor Desktop — Missing Documents

Blackboard SmartView™ Institution: Monument2  Advisor: Demo User(10051005)
Greeting Case Integration

E Demeraphic Tracker Service Indicators Financial Aid Information Financial Aid Communication Student Accounts Academic Records and Registration
Display Name: Select Financial Year:  please select
First Name: Andrew AID YEAR: 2015
Middle Name: X
Last Name: Jackson AID YEAR: 2014
Student ID: 1
Date of Birth: 1967-03-15 (=] AID YEAR: 2013
Email: andrew.jackson@monu

ment.edu [=] Check List

Personal Email:
Marital Status: MARRIED Item Code Description Instructions to Students Status Date Status Satistied
Gender: MALE ISIR Dependent Tax Transcript 2013-12-27 Yes
Natonal 1D m ISIR Household Size Worksheet 2013-12-27 Yes
Preferred Phone: 5714641111
FERPA Indicator: No Release Approved ISIR Scholarship Thank you Letter 2013-12-27 Yes
FERPA Access: MPN Master Promissory Note 2013-12-27 Yes

L Preferred Mailing Address:MA TXP10 Parent Tax Transcript 2013-12-27 Yes
Address 1: 123
Address 2: STREET
Address 3: Correspondence
City: YOURTOWN Comments
State: VA
Postal: 12345
Country: USA

E Parent

23
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Integrated Advisor Desktop — Student Accounts

Blackboard SmartView™ Institution: Monument2  Advisor: Demo User(10051005)
Greeting Case Integration
L] Demographlc Tracker Service Indicators Financial Aid Information Financial Aid Communication Student Accounts Academic Records and Registration
Display Name:
First Name: Andrew Bookstore Charge Limit
Middle Name: X
Account Balance
Last Name: Jackson
Student ID: 1 [=] Account Detail
Date of Birth: 1967-03-15
Email: andrew.jackson@monu Term:Spring 2014
ment.edu
Personal Email:
[=] Term:Fall 2013
Marital Status: MARRIED
Paid Status:Y
Gender: MALE
Date Description Detail Code Charge Amount Payment Amount Invoice Number
National ID: 11
Preferred Phone: 5714641111 2013-11-15 Refund RFND 500.00 7
FERPA Indicator: No Release Approved 2013-11-07 Financial Aid payment FAPAY 500.00 6
FERPA Access:
- 2013-09-15 Refund RFND 1000.00 5
k Preferred Mailing Address:MA
2013-08-25 Financial Aid payment FAPAY 7100.00 4
Address 1: 123
2013-07-22 Room and Board 2013 - 2014 RMBD 5000.00 3
Address 2: STREET
Address 3: 2013-07-21 Fee Fall 2013 FEE 100.00 2
Cy: YOURTOWN 2013-07-20 Tuition Fall 2013 TUIT 1000.00 1
State: VA
Postal: 12345
Country: USA E| Refunds
k Parent
Date/Time Amount
Display Name:
First Name: 2014-01-22 1500.00
Middle Name: 2013-11-15 500.00
Last Name:
2013-09-15 1000.00
Person ID:
Date of Birth:
EMAIL: 1098T
Gender:




Integrated Advisor Desktop — Registration/Records

Blackboard SmartView™ Institution: Monument2  Advisor: Demo User(10051005)

Greeting Case Integration LMS

k Demographic Tracker Service Indicators Financial Aid Information Financial Aid Communication Student Accounts Academic Records and Registration
Display Name:
First Name: Andrew Admissions
Middle Name: X
Enroliment Steps - Overview
Last Name: Jackson
Student ID: 1 [=] Assessment Tests
Date of Birth: 1967-03-15
Email: andrew.jackson@monu Type Code Description Score Date Taken
ment.edu
SAT SAT - MATH 1200 2011-01-01
Personal Email:
Marital Status: MARRIED SAT SAT-READING 1200 2011-01-01
Gender: MALE
National ID: 1111
Preferred Phone: 5714641111 Advisor
FERPA Indicator: No Release Approved
Previous Institution Attended
FERPA Access:
k Preferred Mailing Address:MA [=] Registration Summary
Address 1: 123
Primary Campus Primary Academic Program Primary Field of Study Effective Starting Term
Address 2: STREET
Monument Associate of Science Undeclared Spring 2011
Address 3:
City: YOURTOWN
State: VA Fall 2014 Registration
Postal: 12345
+| Fall 2013 Registration
Country: USA 9
E Parent [=] Fall 2012 Registration
Display Name: Class Class Class Grade Instructor
First N Number Subject Catalog Course Descriptioin Units Status Start End Earned Name Building Room
irst Name:
| 33803 BIOL 101 Introductory Biology 3 *Web 2012-08- 2012-12- @
Middle Name: Registered/Add™" 20 15
Last Name:
36727 POLS 101 Introduction to American 3 “*Web 2012-08- 2012-12- @
Person ID: Gover Registered/Add™ 20 15
Date of Birth: 36815 PSYC 201 Lifespan Development 3 *Web 2012-08- 2012-12- @
EMAIL: Registered/Add™ 20 15
Gender: 39002 CINS 101 Introduction to 3 “Web 2012-08- 2012-12- @

e



Integrated Advisor Desktop — Learning Mgt. System

Blackboard SmartView™ Institution: Monument2  Advisor: Demo User(10051005)
Greeting Case Integration Password Reset
Q Search LMS User k LMS User Information
First Name™: Andrew User Name First Name Last Name Email Address Student ID Birthday Account Status
Last Name™: Jackson test100 Andrew Jackson andrew.jackson@monument.edu 1 1967-03-15 false
BB User: test100
Email: andrew.jackson@monument

2 Blackboard Account

k Course Information

User ID: test100
First Name: Andrew
Last Name: Jackson [=] BIO 211: Biodiversity, Ecology, and Conservation Biology
Email: andrew.jackson@monument.edu
[=] Course Properties [=] Course Instructor Information
[T) Al account information has been verified.
Course BIO 211: Biodiversity, Ecology, and First Name Last Name Email Address Phone Number
name: Conservation Biology
Loren Lovins loren.lovins@monument.edu 555-606-0842

Course ID: BIO_211
Status: Avaliable

Continuous: true

Course true

User

Status:

Course STUDENT
User Role:

[=] ENG 101: First-Year Composition

[=] Course Properties [=] Course Instructor Information
Course name: ENG 101: First-Year First Name Last Name Email Address Phone Number
Composition
Ellen Luzarraga ellen.luzarraga@monument.edu 555-867-5309

Course ID: ENG_101




Integrated Advisor Desktop — CRM /Case Data

Blackboard SmartView™

Greeting m Case Integration LMS  Password Reset

Q Caller Search As

i Caller Search Results

Institution: Monument2  Advisor: Demo User(10051005)

User Name

Email

First Name

Last Name

User ID 1

k Caller Information

User Name * demo

Email andrew.jackson@monument.edu
First Name * Andrew

Last Name * Jackson

User ID 1

Phone Number * 5714641111

Second Phone

Third Phone

Fourth Phone

2/

User Name Email First Name v Last Name
demo andrew.jackson@monument.edu Andrew Jackson

im Case Search Results
Case ID~ Start Date End Date Case Status Summary View
1582-57 05/20/2015 10:24:45 05/20/2015 10:24:45 Queue Assigned when will | receive my financial aid letter in the mail
1582-56 05/19/2015 20:34:58 05/19/2015 20:34:58 Queue Assigned when will | receive financial aid letter
1582-55 05/15/2015 10:28:22 05/15/2015 10:28:22 Closed Financial aid
1582-54 05/15/2015 10:20:59 05/15/2015 10:20:59 Queue Assigned Test
1582-49 05/06/2015 14:17:07 05/06/2015 14:17:07 Closed Financial Aid




Reporting System
SLA Performance & Telephony Data
For Staff



Service Center Dashboard - New

Monument University Student Services Dashboard

In order for you to have full confidence in your service delivery, we will provide access to the lates: data that documents how we are
meeting the specifications of our centract with you. Please find access to recorded calls as well as reporting panels to illustrate our
service delvery and how we are doing compared to our Service Leve! Agreement (SLA) with you.

Telephony & Tickets Recorded Calls

Select Date Range  2015-04-20 > 2015-0% View Report
Telephony Export
Avel of Answer Average Handle Time % of Calls Handled Email/Web Ticket Response Time
80 100 120 ¢ 05 o6 2025 39
60 140
40 160 0. 2
- \,m
0 200 ./
[ Winvies 33 Seconds | o]
Average Speed of Answer Resolution Rate vs SLA Email/Web ticket response time vs. SLA
WASA S W Reschscefase SLA W AesposseTare
: Iml'“ LLII—LI—U
Tickets

gscitre
Business e

Selected Contact Reasons

v

(%Y

W Farciul Ad B Adrissons Bl
W o8 Sgpon M Techeicw Sugpse
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[ ]

Contact

I 268 - VR St Hup Ticeot [l BUSS - Live Crant [l BUSS - Prose Cat
W =88 - Wit Teht Wl Ervs

Monument University Student Services Dashboard

In order for you to have full confidence in your service delivery, we will provide access to the latest data that documents how we are meeting the
specifications of our coniract with you. Please find access to recorded calls as well as reporting panels to illustrate our service delivery and how we
are doing compared to our Service Level Agreement (SLA) with you.

Telephony & Tickets Recorded Calls

Listen to Recorded Calls

Select Period Enter Advisor Name:

o Last 24 Hours Search

- Last 7 Days
(<]
Show entries Seache
Date and Time < Duration < Advisor Name < Listen / Download Audio

05/20/2015 02:46:02 PM 00:12:07 Tracy Guthrie
05/20/2015 02:44:57 PM 00:10:21 LaRussa Lakes
05/20/2015 02:41:57 PM 00:01:05 Shamika G
05/20/2015 02:41:19 PM 00:02:35 Stephanie Torres
05/20/2015 02:38:08 PM 00:02:06 Stephanie Torres
05/20/2015 02:37:57 PM 00:03:43 Melanie Trnidad
052072015 02:32:46 PM 00:02:58 Melanie Trnidad
05/20/2015 02:31:44 PM 00:03:57 Stephanie Torres
05/20/2015 02:30:11 PM 00:10:57 Tracy Guthrie
05/20/2015 02:24:54 PM 00:10:34 Ashley Brocks

Showing 1 to 10 of 45 entries (]
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